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What is LibreOffice?
● A completely free alternative to MS Office:  

Writer, Calc, Impress, Draw, …
– Open-Source software.   Successor to OpenOffice.org (which was a successor 

to Star Office)
– Reasonable (not 100%) support for MS Office file types and others 

● Download from https://www.libreoffice.org  **
– Available for Linux, Windows, macOS
– Collabora offers a version for Android and iOS

**These presentation slides will be posted on the BVCC website



  

 

  

Impress

● A Presentation Manager
– LibreOffice counterpart to MS Office PowerPoint
– Creates a presentation "slide show" for digital projection or printed 

handouts
● Before PowerPoint, presentation slides were typically photographic slides, 

handcrafted by artisans days in advance and expensive to produce;  or a  
cheaper alternative of 8.5"x11" hand-drawn or xeroxed transparencies 
displayed using an overhead projector (which did allow hand 
modifications with markers during a presentation)

● PowerPoint  and later Presentation Managers allowed less-skilled people 
to produce professional-looking presentation slides

The advantage of Presentation Managers isn't just the 
elimination of the expense of photographic slides.

For someone like myself who by nature either does 
things at the last minute, or is constantly making 
revisions to a presentation at the last minute, a 
Presentation Manager is the only way to go.  Having 
to rely on a third party with multi-day turnaround to 
make last-minute slide revisions  is a poor match for 
that kind of personality.



  

 

  

Beginning a New Presentation
● Start Impress
● Select a presentation template or a "blank" template

– Template – one or more master slides with coordinated color scheme or 
artwork as base for building presentation slides

– Each master slide has pre-defined layout, but layout may be changed
– Master slide also has default dimensions and ratio (4:3, 16:9, etc) and 

background, but that can be changed (Slide → Slide Properties…)
– Selecting "Close" without selecting template gives "blank" template



  

 

  

Examples of Templates



  

 

  

Thoughts on Choosing Templates
● Choose a template that doesn't distract from the ideas presented
● Artwork with large contrast differences may make it difficult to read 

overlapping text
● Solid darker backgrounds and significant artwork on every slide makes 

printed copies of presentation for handouts more expensive to print in 
both ink and time 

● Support for creating your own solid or pattern backgrounds and 
backgrounds with gradient between two colors

● Support for background Bitmap image created by image editors like 
GIMP.



  

 

  

Thoughts on Choosing Templates 
● Default templates a major difference between PowerPoint and Impress

– Impress:   23 default templates (but extensions can be installed)
– PowerPoint: 100's of templates and examples & search tools
– Saves much time to settle on a few you like and stick to those

● It is possible to insert master slides from different templates into the 
same presentation

● 16:9 ratio slides probably a better fit than 4:3 for today's monitors, but 
may want to experiment with a specific digital projector, and the 
number of slides that can be printed per page for handouts may be a 
consideration.



  

 

  

"Focus" Template Example

Shown with default User-Interface.
A Template has one or more Master Slides (4 here) 

with different content areas (layout).  Typically 1st is 
for presentation title and others for internal content.

Here the ones with greater white space would likely be 
used for slides needing more content space.

Can click on specific content area to add content. 
Some contain both text icon and square to select 
"image, table, etc", but can always insert such 
specialized content with "Insert" menu option as well.



  

 

Here is an 
Example of Sub-

Title info

Focus Example

This is appearance after entering "Title" text and 
"Sub-Title" text.  Notice text color is pre-set to make 
it visible and Title is larger (but if text area is 
selected and moved so that some letters are over 
white background, those letters won't be visible)

Once you start adding presentation content, do a 
"Save As" to save the presentation.

Would also suggest possible change of User Interface 
from "Standard Toolbar" to "Tabbed" ("View"→ "User 
Interface…")  and "Apply to Impress"



  

 

  

Tabbed User Interface TabsSave/SaveAs

Like MS Office, selecting one of the tabs displays a 
ribbon of tab-specific icons that may be selected.

At the extreme left of the "tabs" line is an icon to 
remove/restore the top menu line (which contains 
under "View" the only way to change the user 
interface)

A little ways in from the left is the Save/Save-As icon, 
which will also contain a red dot if the presentation 
has been changed since the last save.

When this screen image was taken, the sub-menu text 
box had been manually moved to the right of the 
white center to show that the text color was fixed by 
the underlying Master Page, not auto-determined by 
the color behind the text.



  

 

  

Dragging & Dropping Slide to New Place (2nd)

I want my 2nd and subsequent slides to follow pattern 
of model-slide 4.  Select that slide in left navigation 
and drag it between 1st two slides.

The default layout is a slide title and a large content 
area which can contain text, a chart, table, image, or 
A/V link.  The "dot" in front of text shows it will default 
to bullet points.

When typing points, "Enter" will advance to next point,
"SHIFT-Enter" will force new line within current point.  

Tab right or left at beginning a point to change to 
different point level.   Points will start off at default 
font-size, sub-points at reduced font size.  If too 
many points to fit inside text window, font-size is 
reduced to fit.  If too many points on one slide, text 
will be too small for audience to read!
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Multiple Points
● Point 1

– Sub point 1 a
– Sub point 1 b

● Point 2
● Point 3
● Point 4
● Point 5
● Point 6
● Point 7 .  After typing this line, font size was auto-reduced

The pre-defined text box was set up so that all but a 
small part of the bottom corners fall outside the dark 
colored areas.  If grey text were to fall within those 
areas, it would be unreadable.
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Font Samples
DejaVuSans (default)
DejaVuSansBold
TeXGyreChorus
LiberationSerif
(many others)

DejaVuSansOutline
DejaVuSansShadowDejaVuSansShadow
Superscript1

Subscript2

Can click on a different layout (right on Layout ribbon) 
to change the slide layout (changed here to title + 2 
side by side content sections)

Default for text is list points, but can toggle on/off on 
Home ribbon.

Available fonts are managed by Operating System.  
LibreOffice comes with a set.  Extensions possible 
from other sources.  If MS Office installed on same 
system, might (not sure) be able to see MS Office 
fonts as well in LibreOffice.

Character attributes can be changed by selecting 
characters, right-click, select "character" and setting 
desired font, color, other attributes  Some attributes 
can also be changed from the Home ribbon.  Usually 
let font sizes be chosen by Impress. 
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Styles
● Text uses "Styles" similar to Writer & MS Word

– But not nearly as flexible or useful in "Impress"
– Assigned style is fixed by text usage context:  Title, Subtitle, 

Notes, Outline1 – Outline 9 (list levels)
– Style  definitions are associated with a specific Master Page, 

not with the entire document.
– Primarily used when defining a Master Page to make font 

color appropriate for Slide color supplied in Master Page
– Customization required on individual slides is done by 

"direct formatting", not by modifying styles
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Abby – Image & Video

Can either click on the Insert Image icon in the empty 
contents box, use Insert Image in the Insert Ribbon, 
or use Image… submenu option in Insert Menu.

If the image is a high-resolution camera image. 
probably want to right-click on the image and select 
"Compress" to reduce the resolution to reduce the 
storage space required for the presentation.

Can change the size of the image by dragging the 
corners and then move the image manually if 
needed.  Can also drag from center of a side of the 
image, but this will distort the image by changing 
either the height or width, but not both.

Images can be inserted on top of text or other content, 
but you may have to manually position things so they 
don't interfere with each other.

.mp4 .mov video doesn't work in LO on Windows 10
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Manually Position Text and Other Items
You can

manually positi
on

Text boxes to your hearts content 
and even rotate them

You can also use drawing tools to make 
shapes and lines, although that can get 
rather tedious.
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Note View
● Select Notes display under "View" to edit notes

– Associated with slide – will not display as part of slide, 
but may be printed with or included in PDF version of the 
slide show.

– If have a monitor plus digital projector, may be seen by 
presenter on monitor when slide is projected as aid to 
discussing slide material

– Can also be used as means to give some of the 
presenter's description of the slide for those only able to 
view the PDF version of the slide show
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Slide Sorter View
● Select from "View" menu or "View" tab ribbon
● Provides thumbnail view of all slides

– Makes it easy to move slides around – drag & drop
– Can select and delete unneeded slides (like unused 

Master Slides)
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Slide Sorter View
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Outline View

Another alternative "View" of presentation
Can be used as a quick way to review all the 

presentation points and sub-points.
Can also be a quick way to enter multiple slide titles 

and points and sub-points. then go back into 
"Normal" slide view and possibly split one slide with 
too much text into multiple slides, add images, etc.
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Special Effects
● Change pattern & duration of slide transition – Slide 

Show → Slide Transition  
● Major points can appear one by one or be 

emphasized with each mouse click –
select point text, click on "Custom Animation" (gold 
star on right Sidebar), select Add, Category 
(Entrance, Emphasis,…) and Effect

● Use sparingly – over-use is distracting

The rules for what is acceptable in an ad are of course 
different than in a presentation intended  to convey 
information to an interested audience.  

Ads do their best to attract a disinterested or even 
hostile audience to pay any attention at all; and many 
pharmaceutical ads do their best to distract you from 
required citing of unpleasant side effects by using 
distracting visual effects and unrelated images to 
convey impressions of "joy" and "happiness" while 
describing debilitating and possibly fatal side effects!
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Gallery Art
● "Insert" tab,  "Gallery", select Category, 

specific item, drag & drop onto slide.
Some items designed to add text,
or even consist of pieces that can
be moved and separately
positioned

Text

Text

Text

Moved 
from 
original 
spot

Text

Text

This is another area where PowerPoint probably has 
more built-in support.   Suspect a search will find 
additional Internet sources for artwork that can be 
used with LibreOffice Impress – just requires more 
work.



  

 

  

Including Slides From another Presentation
● Open both the From and To presentation
● Select one or more slides in the left navigation window of the From 

presentation, right-click and "Copy"
● Select the To presentation window, position the cursor where the 

slides are wanted in the left navigation window of the To 
presentation, right-click and "Paste"

● If the pasted slides use Master Page(s) not originally in the To 
presentation, this adds those master pages.   This is one way to use 
Master Pages from two different templates in the same presentation.



  

 

  

Adding Simple Tables and Charts

Specify number of columns and rows. Manually enter data
1 2 3

Row 1 Row 2 Row 3 Row 4
0

2

4

6

8

10

12

Column 1
Column 2
Column 3

Right click on 
chart to get table 
into which values 
can be entered 
and change chart 
attribute



  

 

  

Adding More Complex Graph From Calc

● Right Click on graph in a Calc spreadsheet and paste into 
slide page:
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Giving Slide Show
● "Slide Show" tab 

– Slide show settings:  Full-screen vs window, Display 1, 2, auto
– Start-From-First vs Start-From-Current
– Next/Prev slide (PgUp/PgDown, Up/Down arrow, mouse scroll, left 

click;   ESC to exit Slide Show
– If full-screen and two monitors, takes over both monitors: slide 

show on one, presenter screen with current & next slide & notes on 
2nd screen

● Some issues with Zoom and Impress not always sharing monitors 
gracefully



  

 

  

Generate PDF of Presentation
● If want a printed version, suggest instead generate PDF version and later 

print from that after seeing exactly how the entire presentation will look
– "File" menu → "Export…" → "Export as PDF…" to give options
– Under "General" PDF Options, leave all items under "Structure" unchecked to 

just get PDF pages that are the slide images.   Check both "Export notes pages" 
and "Export only notes pages" for each PDF page to to include a slightly-
reduced slide image plus the notes for that slide.  Checking just "Export notes" 
will  give a PDF with all slide images followed by all slides plus notes.

– If you have a utility that will re-arrange PDF pages and most slides do not have 
notes, you can merge pages from the two PDF versions so that only non-blank 
note sections are included in the final PDF document



  

 

  

Another Custom Background Example

● Started with JPG camera photo – modified with GIMP
– Cropped to 16:9 image width-height ratio
– Levels & gamma adjusted to lighten & reduce contrast for 

"watermark" effect so background doesn't obscure text
– Resolution reduced and saved as JPG
– Image imported (Slide Properties) into Impress as a background 

"Bitmap" image (worked with JPG)



  

 

  

Compatibility Issues with PowerPoint
● Presenting an Impress Document using PowerPoint mostly works, but should be avoided 

without previewing and editing first
– Text content transfers pretty  consistently but

● Point bullets and indentation may be off
● May be some differences in fonts used for text
● Manually positioned text may be positioned incorrectly
● Manually positioned  images may be positioned differently
● Background images added to a slide rather than to a Master Page are ignored
● Embedded Calc graphs may be displayed differently (Excel vs Calc issues) – e.g. Date axis labels display as the 

internal numeric ordinal used for the date, not formatted as date.
● Some other features could have issues

– In an "emergency" would be better than no slides at all, but fewer "surprises" if presentation given 
with the same version of the same application used to create it

● Similar caveats for using Impress to display a document created with PowerPoint

These compatibility issues were seen displaying this 
document using PowerPoint.  Most could be cleaned 
up by re-editing any problem slides in PowerPoint 
and then saving the document as a PowerPoint 
document. (PPTX)

Resolving the issues with a CALC graph probably 
would require porting the ODS worksheet to EXCEL, 
correcting the graph formatting issues there, and 
then copy/paste of the revised graph from EXCEL to 
the PowerPoint slide..

Some PowerPoint features cannot be represented in 
an Impress ODP file, and some Impress features 
cannot be represented in a PPTX file.  I would trust 
PowerPoint to do a better job of converting from/to 
an ODP file than Impress working with proprietary-
format PPTX files.



  

 

  

QUESTIONS?


